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Preface

Manual Information

Purpose
This manual details the features, installation, operation, maintenance, 

and specifications for the XHD6801+ broadcast-quality up/cross/down- 

converter.

Audience
This manual is written for engineers, technicians, and operators 

responsible for installation, setup, maintenance, and/or operation of the 

XHD6801+ broadcast-quality up/cross/downconverter. 

Revision History
Table P-1. Revision History of Manual

Edition Date Comments

A June 2008 Initial release
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Writing Conventions
To enhance your understanding, the authors of this manual have 

adhered to the following text conventions:

Obtaining Documents
Product support documents can be viewed or downloaded from our 

Web site. Alternatively, contact your Customer Service representative 

to request a document.

Table P-2. Writing Conventions

Term or 

Convention
Description

Bold Indicates dialog boxes, property sheets, fields, buttons, 

check boxes, list boxes, combo boxes, menus, 

submenus, windows, lists, and selection names

Italics Indicates E-mail addresses, the names of books or 

publications, and the first instances of new terms and 

specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as 

ENTER, TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a 

DOS entry or something you type into a field

> Indicates the direction of navigation through a hierarchy 

of menus and windows

hyperlink Indicates a jump to another location within the 

electronic document or elsewhere

Internet address Indicates a jump to a website or URL

Note
Indicates important information that helps to avoid and 

troubleshoot problems
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Unpacking/Shipping Information

Unpacking a Product
This product was carefully inspected, tested, and calibrated before 

shipment to ensure years of stable and trouble-free service. 

1. Check equipment for any visible damage that may have occurred 

during transit. 

2. Confirm that you have received all items listed on the packing list. 

3. Contact your dealer if any item on the packing list is missing.

4. Contact the carrier if any item is damaged.

5. Remove all packaging material from the product and its associated 

components before you install the unit.

Keep at least one set of original packaging, in the event that you need to 

return a product for servicing. 

Product Servicing
Except for firmware upgrades, XHD6801+ modules are not designed 

for field servicing. All hardware upgrades, modifications, or repairs 

require you to return the modules to the Customer Service center.

Returning a Product

In the unlikely event that your product fails to operate properly, please 

contact Customer Service to obtain a Return Authorization (RA) 

number, then send the unit back for servicing. 

Keep at least one set of original packaging in the event that a product 

needs to be returned for service. If the original package is not available, 

you can supply your own packaging as long as it meets the following 

criteria:

� The packaging must be able to withstand the product’s weight.

� The product must be held rigid within the packaging.

� There must be at least 2 in. (5 cm) of space between the product and 

the container.

� The corners of the product must be protected.

Ship products back to us for servicing prepaid and, if possible, in the 

original packaging material. If the product is still within the warranty 

period, we will return the product prepaid after servicing.
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Restriction on Hazardous Substances (RoHS) 

Compliance

Directive 2002/95/EC—commonly known as the European Union (EU) 

Restriction on Hazardous Substances (RoHS)—sets limits on the use of 

certain substances found in electrical and electronic equipment. The 

intent of this legislation is to reduce the amount of hazardous chemicals 

that may leach out of landfill sites or otherwise contaminate the 

environment during end-of-life recycling. The Directive, which took 

effect on July 1, 2006, refers to the following hazardous substances: 

� Lead (Pb)

� Mercury (Hg)

� Cadmium (Cd)

� Hexavalent Chromium (Cr-V1)

� Polybrominated Biphenyls (PBB)

� Polybrominated Diphenyl Ethers (PBDE)

According to this EU Directive, all products sold in the European Union 

will be fully RoHS-compliant and “lead-free.” (See our website for 

more information.) Spare parts supplied for the repair and upgrade of 

equipment sold before July 1, 2006 are exempt from the legislation. 

Equipment that complies with the EU directive is marked with a 

RoHS-compliant emblem, as shown in Figure P-1.

Figure P-1. RoHS Compliance Emblem
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Waste from Electrical and Electronic 

Equipment (WEEE) Compliance

The European Union (EU) Directive 2002/96/EC on Waste from 

Electrical and Electronic Equipment (WEEE) deals with the collection, 

treatment, recovery, and recycling of electrical and electronic waste 

products. The objective of the WEEE Directive is to assign the 

responsibility for the disposal of associated hazardous waste to either 

the producers or users of these products. As of August 13, 2005, 

producers or users are required to recycle electrical and electronic 

equipment at end of its useful life, and may not dispose of the 

equipment in landfills or by using other unapproved methods. (Some 

EU member states may have different deadlines.)

In accordance with this EU Directive, companies selling electric or 

electronic devices in the EU are affixing labels that indicate such 

products must be properly recycled. (See our website for more 

information.) Contact your local sales representative for information on 

returning these products for recycling. Equipment that complies with 

the EU directive is marked with a WEEE-compliant emblem, as shown 

in Figure P-2.

Figure P-2. WEEE Compliance Emblem
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Safety

Carefully review all safety precautions to avoid injury and prevent 

damage to this product or any products connected to it. If this product is 

rack-mountable, it should be mounted in an appropriate rack using the 

rack-mounting positions and rear support guides provided. It is 

recommended that each frame be connected to a separate electrical 

circuit for protection against circuit overloading. If this product relies 

on forced air cooling, it is recommended that all obstructions to the air 

flow be removed prior to mounting the frame in the rack. 

If this product has a provision for external earth grounding, it is 

recommended that the frame be grounded to earth via the protective 

earth ground on the rear panel.

IMPORTANT! Only qualified personnel should perform service 

procedures.

Safety Terms and Symbols in this Manual

WARNING

Statements identifying conditions or practices that may 

result in personal injury or loss of life. High voltage is 

present.

CAUTION

Statements identifying conditions or practices that can 

result in damage to the equipment or other property.
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Introduction

Overview

XHD6801+ modules offer broadcast-quality HD/SD-SDI 

upconversion, crossconversion, and downconversion with aspect ratio 

conversion (ARC), and closed-captioning support. There are three basic 

varieties available: 

� XHD6801+UCT up/crossconverter

� XHD6801+DT downconverter 

� XHD6801+UCDT up/cross/down converter 

XHD6801+UC and XHD6801+D and can be upgraded in the field to 

full up/cross/down converter functionality. 

This chapter includes the following topics:

� “Product Description” on page 2

� “Module Description” on page 6

Note

XHD6801+ modules must be installed in frames with fans. 

FR6802+DM and 6800/7000 series frames also do not support 

these products.
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Product Description

XHD6801+ modules provide conversion between SD-SDI and HD-SDI 

video. They include aspect ratio conversion (ARC) capabilities, and can 

accept both embedded audio and ANC data.

The SDI input has error monitoring capabilities in the SD mode (EDH) 

and in HD mode (CRC), and supports external or midplane genlock 

sources.

You can control XHD6801+ modules using the following methods:

� Card edge controls

� +Pilot Lite

� CCS-enabled hardware and software control products

Additionally, you can use SNMP control systems and HTTP (Internet) 

browsers if you purchase the required licenses. Contact your Customer 

Service representative for more details.

Main Features
Important XHD6801+ features include the following:

� Upconversion of SD-SDI video to broadcast-quality HD-SDI video 

(XHD6801+UCT and XHD6801+UCDT)

� Crossconversion of HD-SDI video (XHD6801+UCT and 

XHD6801+UCDT) 

� Downconversion of HD-SDI video to SD-SDI video 

(XHD6801+DT and XHD6801+UCDT)

� Inputs

� Auto-sensing HD/SD-SDI input with embedded audio data, 

error monitoring, VANC data such as WSS/VI/AFD and 

optional closed captioning and teletext

� Analog composite genlock input with support for tri- and 

bi-level sync 
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� Outputs 

� Four equalized and reclocked HD/SD-SDI outputs of the SDI 

input that can be configured to be frame synchronized

� Two HD/SD-SDI outputs carrying the converted program 

signal with: 

� Embedded audio

� Video Ancillary Data Space (VANC) data, including Wide 

Screen Signalling (WSS), Video Index (VI), and Active 

Format Description (AFD) 

� Closed captioning and teletext capabilities

� Two configurable HD/SD-SDI outputs carrying either the 

converted program signal or the key or monitor signal (with 

OSD for displaying control parameter settings) 

� User-selectable input/output standards and formats 

� Video Processing

� 10-bit up-, down-, cross-, and aspect ratio conversion with 

motion adaptive de-interlacing 

� Color-space conversion between SD-SDI (601) and HD-SDI 

(709) 

� User-configurable aspect ratio conversion (H/V size and 

position) for picture resizing, with eight selectable 

internally-generated color ARC backgrounds

� Variable aspect ratio conversion with five user presets and fixed 

preset aspect ratios that include 16:9 anamorphic, 16:9 middle 

cut, 14:9, 4:3, and pixel true 

� Aspect ratio adjustment according to embedded WSS/VI/AFD 

information

� User-selectable video frame delay of up to eight frames

� Video frame delay of up to eight frames through the entire 

video path

� Clean cut transition during aspect ratio change
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� ANC Processing

� WSS, VI, and AFD detection, insertion, or re-insertion 

� Automatic correction of AFD codes if incoming AFD 

information is incorrect

� 24-bit audio processing

� Embedded audio processing (demultiplexing from SDI, delay/

sync, sample rate conversion, and remultiplexing into SDI) 

� Support for 4 groups (16 channels) of embedded audio 

� Support for compressed and linear PCM audio data in the same 

audio group 

� Mono level swapping of audio channels

� Handling of any embedded compressed audio with fixed delay

� Audio delay that matches video propagation plus additional 

user delay of up to 1.2 seconds

� Store and recall of ARC presets through SNMP and CCS-enabled 

hardware and software controls

� Loss of video (LOV) modes, including pass, freeze, and black

� Built-in HD/SD-SDI test generator containing white, black, 

frequency sweep, cross-hatch pattern, color bars signal, and Safe 

Area Graticles (SAG) key 

� Support for Q-SEE compliant thumbnails when installed in a 

FR6802+QXF frame 

� Soft edge rectangle key output of non-picture area 

Software Key Options
The following software option keys are available:

� XHD68+D-UG-UCD software key converts a XHD6801+DT to a 

full XHD6801+UCDT up/cross/down converter.

� XHD68+UC-UG-UCD software key converts a XHD6801+UCT 

to a full XHD6801+UCDT up/cross/down converter.
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Applications
The XHD6801+ modules are suitable for the following applications:

� Final conversion to a high- or standard-definition output, regardless 

of input format 

� Bridging between high-definition and standard-definition 

installations in a mixed signal facility

� Bridging between 720p and 1080p high-definition installations 

� Transitioning small market broadcasters requiring high-quality 

conversion

� Ingestion of high-definition or standard-definition signal into a 

facility running either video standard
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Module Description

Front Module
Figure 1-1 shows the position of the LEDs and module controls on the 

front of the XHD6801+ modules.

Figure 1-1. Typical 6800+ Module

Table 1-1 on page 7 briefly describes generic 6800+ LEDs, switches, 

and jumpers. 

Module 
status LED

Mode select 
rotary 
switch

Navigation 
toggle 
switch

Monitoring 
LEDs

Remote/local 
control jumper

Extractor 
handle

Control 
LEDs
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Table 1-1. Generic 6800+ Module Features

Feature Description

Module status 

LEDs

Various color and lighting combinations of these LEDs 

indicate the module state. See “LEDs and Alarms” on 

page 69 for more information.

Mode select 

rotary switch

This switch selects between various control and 

feedback parameters.

Navigation 

toggle switch

This switch navigates up and down through the available 

control parameters:

� Down: Moves down through the parameters

� Up: Moves up through the parameters

Control LEDs Various lighting combinations of these Control LEDs 

(sometimes referred to as “Bank Select LEDs”) indicate 

the currently selected bank. See “Bank Select LEDs” on 

page 34 for more information.

Monitoring 

LEDs

Each 6800+ module has a number of LEDs assigned to 

indicate varying states/functions. See “Monitoring 

LEDs” on page 69 for a description of these LEDs.

Local/remote 

control jumper

� Local: Locks out external control panels and allows 

card-edge control only; limits the functionality of 

remote software applications to monitoring 

� Remote: Allows remote or local (card-edge) 

configuration, operation, and monitoring of the 

XHD6801+

See page 14 for more information on jumpers.
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Back Module

Figure 1-2. XHD6801+ Back Module

Figure 1-3. GPI In/Out Pinouts

SDI PROGRAM OUT

SDI IN 2 SDI IN 1

SDI PGM/MONITOR OUT

SDI DA OUT

REF IN

AUD DELAY / 6HZ

GP IN/OUT

8

GPI 1 

1

GND

GPI 2 

GPI 3 

GPI 4 

GND 

GPO 1 

GPO 2 
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Table 1-2 describes each back module connector.

Table 1-2. Back Module Connector Descriptions 

Back Module Label Description

SDI In 1 and SDI In 2 Inputs HD/SD-SDI video for up, down, or 

cross-conversion or reclocking; HD/SD-SDI 

signals can also be input for reclocking.

SDI DA Out (4) Outputs SD or HD reclocked video output signals; 

video from these outputs by-passes the module’s 

scalar processor; configurable for either reclocked 

or frame sync outputs

SDI Program Out (2) Outputs HD/SD-SDI converted video

Audio Delay / 6 HZ Outputs the output audio delay signal

SDI Program/Monitor 

Out (2) 

Outputs a program signal for monitoring 

purposes; an on-screen display of XHD6801+ 

control parameters can be enabled on these 

outputs 

Reference In Inputs a bi-level (NTSC/PAL-B) or tri-level sync 

(1080i/1080p) external video reference source 

that can be internally terminated using a jumper 

(see page 75 for the video standards supported)

GPI In/Out Provides four GPI inputs and two GPI outputs for 

automation (these are open collector style inputs 

with approximately 10 KΩ pull-ups to +5V that 

can use “contact closure-to-ground” switches) 
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Signal Flow

Figure 1-4. XHD6801+ Signal Flow Diagram 

Reference 

in

Frame 
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Video 
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CPU 

Monitoring and 
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Installation

Overview

This chapter describes the XHD6801+ installation process, including 

the following topics:

� “Maximum 6800+ Frame Power Ratings” on page 12

� “Unpacking the Module” on page 13

� “Setting Jumpers” on page 14

� “Installing XHD6801+ Modules” on page 17

� “XHD6801+ License Keys” on page 17

� “Upgrading Module Firmware” on page 18

Caution

Before installing this product, read the 6800+ Series Safety 

Instructions and Standards Manual shipped with every frame 

installation and operation manual. This information is also available 

on our website. The safety manual contains important information 

about the safe installation and operation of 6800+ series products.

See your frame installation and operation manual for information about 

installing and operating an FR6802+ frame and its components. 
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Maximum 6800+ Frame Power Ratings

The power consumption for one XHD6801+ module is 17.5 W. 

Table 2-1 shows the maximum allowable power ratings for 6800+ 

frames. Note the given maximums before installing any 6800+ modules 

in your frame.

Due to high levels of heat dissipation, XHD6801+ modules should not 

be installed in frames without fans. The modules cannot be installed in 

FR6802+DM and 6800/7000 series frames.

Note

To maintain proper temperatures, ensure that the front panel is 

closed at all times, and that the fan module is fully operational. 

* Each front module requires three slots.

** Although XHD6801+ modules require more than 15.75 Watts over three slots, the 

actual consumption is considered acceptable if no more than 5 modules are installed.

Table 2-1. Maximum Power Ratings for 6800+ Frames

6800+ Frame Type
Max. Frame 
Power 
Dissipation

Max. Number of 
XHD6801+ 
Modules

Max Power 
Dissipation for 
Three Slots*

FR6802+QXF

(frame with AC or DC 

power supply)

120 W 6 18 W

FR6802+XF

(frame with AC power 

supply)

120 W 6 18 W

FR6802+XF48

(frame with DC power 

supply)

105 W 5 15.75 W**
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Unpacking the Module

Preparing the Product for Installation
Before you install the XHD6801+, perform the following:

� Check the equipment for any visible damage that may have 

occurred during transit.

� Confirm receipt of all items on the packing list. See “Checking the 

Packing List” below for more information.

Note

Contact your Customer Service representative if parts are 

missing or damaged.

� Remove the anti-static shipping pouch, if present, and all other 

packaging material.

� Retain the original packaging materials for possible re-use.

See “Unpacking/Shipping Information” on page ix for information 

about returning a product for servicing.

Checking the Packing List

Table 2-2. Available Product Packages

Ordered Product Content Description

� XHD6801+UC up/

crossconverter 

� XHD6801+D 

downconverter 

� XHD6801+UCD up/

cross/downconverter 

� One front module

� One back module

� One XHD6801+ Broadcast-Quality Up/

Cross/Downconverter Installation and 

Operation Manual
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Setting Jumpers

The XHD6801+ module has the following jumper settings: 

� “Local/Remote Jumper” on page 14 

� “External Reference Termination Jumper” on page 15

� “Input/Output Audio Delay/6 Hz Jumper” on page 16 

Figure 2-1 shows the location of the jumpers.

Figure 2-1. XHD6800+ Jumpers

Local/Remote Jumper

Follow this procedure to set the LOC/REM jumper for either local or 

remote control:

1. Locate the LOC/REM control jumper on the module (beside the 

mode select rotary switch). Figure 2-1 on page 14 shows the 

standard location of the LOC/REM jumper.

Local/Remote 
jumper

Jumper J3 

Input/Output Audio Delay/6 Hz

Jumper J1

External reference termination
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2. Place a jumper on pins 1 and 2 to set the module for Remote 

control, or pins 2 and 3 to set the module for Local control. See 

Figure 2-2.

Figure 2-2. Remote/Local Control Settings 

Note

You must configure modules for local or remote operation prior to 

power-up. To change the configuration, first remove power from the 

module, reset the jumper, and then reapply power. The white 

triangle near the jumper pins on the module indicates pin 1.

See Table 1-1 on page 7 for more information on local/remote control 

jumper functionality.

External Reference Termination Jumper

Follow this procedure to set the external Reference Input Termination 

jumper:

1. Locate jumper J1 on the module.

(Figure 2-1 on page 14 shows the location of the jumper.)

2. Place a jumper on pins 1 and 2 to set the module for 75Ω 

Termination, or pins 2 and 3 for No Termination (see Figure 2-3).

Figure 2-3. Genlock Termination Settings

1      2      3 1      2      3

Remote control Local control

No Termination75Ω Termination

1      2      3 1      2      3
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Input/Output Audio Delay/6 Hz Jumper

Follow this procedure to set the Input/Output Audio Delay/6 Hz 

jumper:

1. Locate jumper J3 on the module.

(Figure 2-1 on page 14 shows the location of the jumper.)

2. Place a jumper on pins 1 and 2 to set the module for 6 Hz input, or 

pins 2 and 3 to set input/output audio delay output (see Figure 2-3).

Figure 2-4. Genlock Termination Settings

1      2      3 1      2      3

6 Hz I/O audio delay output
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Installing XHD6801+ Modules

XHD6801+ products have triple-width back modules. These products 

cannot be installed in frames without fans, or in FR6802+DM and 

6800/7000 series frames.

See the FR6802+ Frames Installation and Operation Manual for 

information about installing and operating an FR6802+ frame and its 

components.

XHD6801+ License Keys

Table 2-3 lists the available XHD6801+ feature upgrade license keys.

To enter a license key, you must use a NUCLEUS control panel, or a 

CCS software application, such as CCS + Pilot Lite, Pilot, or 

Navigator. See page 36 for information about entering license keys.

Table 2-3. Available License Keys

License Key Order 
Number

Feature Upgrade

XHD6801+D-UCD Downconverter upgraded to full up/cross/

downconversion capability

XHD6801+UC-UCD Up/crossconverter upgraded to full up/cross/

downconversion capability
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Upgrading Module Firmware

Firmware upgrading is a routine procedure that you must perform to 

install newer versions of software on 6800+ modules. CCS Pilot, 

Co-Pilot, or Navigator software version 3.1.1 or later is required for this 

procedure. The frame must contain or be connected to another frame 

that contains an ICE6800+ or a 6800+ETH module. During the 

upgrade procedure, the affected modules are automatically rebooted.

In the unlikely event that the upgrade fails (because of such situations 

as network interruptions, power failures, etc.), the module may not 

respond to controls and will appear to be non-functional. In that event, 

follow the procedures described in “Correcting a Failed Upgrading 

Procedure” on page 21.

Upgrading the Firmware
You can upgrade your 6800+ module’s firmware using the Software 

Upgrade tool. This tool is included with CCS Pilot, Co-Pilot, or 

Navigator software version 3.1.1 or later.

Caution

The File Transfer tab is not meant to be used for firmware 

upgrades. Use the Software Upgrade tool to upgrade module 

firmware.

To upgrade your module’s firmware, follow these steps:

1. Download the most recent appropriate upgrade package from our 

website or from your CD-ROM.

2. If the affected module has not been discovered, perform the 

Discovery operation, as described in “Discovering an XHD6801+ 

Module” on page 28. 

Note

Information about discovering modules can also be found in 

your CCS software application manual or online help. (If you 

cannot discover the device, see “Manually Adding a Device to 

the Discovery or Network Folder” on page 22.)
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3. From the Tools menu, select Software Upgrade. 

The Software Upgrade window opens or is brought to the 

foreground.

Figure 2-5. Software Upgrade Tool’s New Transfer Tab

4. On the New Transfer tab, click Add.

The Device Selection dialog box opens.

5. Select one or more devices, and then click OK to close the Add 

Device dialog box.

Note

You can only add one device from each IP address. All items in 

a frame have the same IP address. 

The selected devices appear in the table under Device Name. These 

devices will receive the same upgrade package. 

6. Before proceeding with the firmware upgrade, you can—

� Highlight the module’s position in the Navigation window by 

clicking Find Device. 

Package Info 
includes a list of the 
components 
contained in the ZIP 
file. 

Version Info lists 
the firmware version 
currently installed on 
the module.
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� View the firmware version currently installed on the module by 

clicking Version Info.

7. Press Browse... to select the firmware upgrade package (ZIP file). 

A standard Windows File Selection dialog opens. 

8. Choose the upgrade ZIP file on a local or network drive. 

The selected file’s path name is displayed in the edit box to the left 

of the Browse… button.

Note

The extraction process of the ZIP file is handled as part of the 

upgrade process. You do not need to extract the files yourself. 

You can view the contents of the ZIP file by clicking Package 

Info. 

9. Press Submit Transfer... 

A dialog box opens, requesting confirmation that you want to 

proceed with the request. If you have multiple devices selected, 

multiple transfer tasks are submitted—one per device.

The transfer now progresses. You may minimize the Software 

Upgrade window, continue with other tasks, or switch to the 

Progress tab to view the status of the transfers. 

Note

Closing the Software Upgrade window does not effect any of 

the transfer processes that may be running in the background. 

If you try to log off or exit the CCS software while a transfer is 

underway, a notification window will alert you that processes 

are still active and will ask if you want to terminate these 

processes.

10. To monitor the progress of the firmware upgrade procedure, click 

the Progress tab. When the firmware upgrade is complete, 

Completed is displayed in the Transfer Status column.

Figure 2-6. Firmware Upgrade Complete
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Correcting a Failed Upgrading Procedure
Firmware upgrades may fail in the event of network interruptions, 

power failures, or if the wrong upgrade package was transferred to the 

module. These problems can be corrected by upgrading the firmware 

while the module is in Boot Loader mode. The upgrade won't work 

unless you put the module in Boot Loader mode.

Note

If you have not already downloaded the most recent appropriate 

upgrade package from our website or from your CD-ROM, do so 

now.

Putting the Module in Boot Loader Mode

Follow these steps to put your the module in Boot Loader mode:

1. Remove the affected module from the 6800+ frame.

Figure 2-7. Buttons on a Typical Card Edge

2. Set the hex switch to F. 

3. While pressing the Navigation toggle switch down, reinsert the 

module into the frame.

If your device is listed in the Discovery or Network folder, you can 

continue the firmware upgrade as described in “Upgrading the 

Firmware” begining with step 3 page 18. If not, you must manually add 

the device to the Discovery or Network folder. To do this, see the next 

section. 

Hex switch (mode 
select rotary switch)

Navigation toggle 
switch
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Manually Adding a Device to the Discovery or Network Folder

If your device is not listed in the Discovery or Network folder, you 

must manually add it to these folders. After you add the device, you can 

use the Software Upgrade dialog box to continue with the module 

firmware upgrade.

To manually add a device to the Discovery or Network folder, follow 

these steps:

1. Enter Build mode, and then drag or copy and paste the module’s 

device icon from the Catalog folder into the Network or Discovery 

folder.

2. Right-click the device icon, and then select Properties. 

3. On the Device tab of the Navigation Properties box, enter the IP 

address of the frame that holds the module. (See Figure 2-8.)

Figure 2-8. Navigation Properties Box

Caution

Do not make changes in the last field (located above and to the 

right of the Set Default button). If you do, you will need to begin the 

process of adding devices to the Discovery or Network folder 

again. 

Do not make changes in 
this field

Enter frame IP address here

Frame number=0 Slot number=17Must be set to 1
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4. In the third field, enter

1.0.[slotnumber]

(where, for example, 1.0.5 would refer to the module in slot 5 of the 

frame number 0). 

5. Close the window.

6. You can now continue your firmware upgrade as described in 

“Upgrading the Firmware” begining with step 3 on page 18. 
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Overview

This chapter describes how to operate the XHD6801+ using card-edge 

controls or by using a CCS software and hardware controls application 

such as + Pilot Lite, Pilot, or Navigator. 

See the following documents for detailed information on how to operate 

this product remotely:

� + Pilot Lite User Manual for serial interface

� CCS Pilot, CoPilot, Navigator, or NUCLEUS Network Control 

Panel, LCP-3901-1U/RCP-CCS-1U manuals for Ethernet interface

The following topics are discussed in this chapter:

� “Operating Notes” on page 26

� “Video Processing Modes” on page 27

� “Q-SEE Compliant Thumbnails” on page 31

� “Changing Parameter Settings” on page 32

� “Entering License Keys” on page 36

� “Aspect Ratio Conversion” on page 37

� “Active Format Description” on page 40

� “Closed Captioning and DVB Teletext Captioning” on page 52

� “Audio Configuration” on page 53

� “GPI” on page 56

� “Video Keying” on page 57
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Operating Notes

When setting the control parameters on the XHD6801+, observe the 

following:

� When you change a parameter, the effect is immediate. However, 

the module requires up to 20 seconds to save the latest change. 

After 20 seconds, the new settings are saved and will be restored if 

the module loses power and must be restarted. 

� For proper operation, the output HD standard frame rate should 

match or double the reference standard frame rate.

� The manufacturer recommends that you terminate any unused 

coaxial output connectors with a 75Ω connector.
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Video Processing Modes

The XHD6801+ operates in three fundamental video processing modes. 

Each of these modes is available in all three XHD6801+ versions 

(XHD6801+UC, XHD6801+D and XHD6801+UCD). 

Note

Some user controls such as input and output video standard, 

phasing, and LOV may operate differently between these 

processing modes. Also, there are some requirements on the video 

format on each of the outputs, and these requirements vary 

between each processing mode.

Mode 1: Scaled Outputs with Re-clocked Inputs

Figure 3-1. Scaled Outputs with Re-clocked Inputs

This mode is active when you select Reclock in Video > Output > DA 

Output Select.

Four re-clocked outputs of the input video with four scaled outputs are 

available in this mode. This makes it possible to configure the 

XHD6801+ as a combined four-output DA and a four-output up/cross/

downconverter. The following special features and limitations apply to 

this video processing mode:

� The input video standard control (Video > Input > SDI Input 

Standard Set) applies to the video frame synchronizer only and has 

no effect on the re-clocked outputs. If the input video format does 

Video frame 
sync

Scalar and

audio /ancillary 

processor

Reclocked 

outputs

Program 
and monitor 

outputs

SDI 

input
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not match the input standard control setting or if the input video is 

lost, both frame synchronizer and the scalar processor will operate 

in LOV mode.

� The output video standard of the scalar is selectable through the 

scalar output video standard control (Video > Output > Output 

Video Standard Select). However, the video format of the 

re-clocked outputs is not controllable and is always the same as the 

input video format.

� The horizontal and vertical phasing controls will apply to both 

video frame synchronizer and scalar processing as a single block. 

The phasing controls (Video > Processing > Synchronizer) have 

no effect on the re-clocked outputs.

� If the input video format does not match the input standard control 

setting or if the input video is lost, the program and monitor outputs 

will either be frozen, undetermined (pass mode), or black—

according to the LOV mode setting (Video > Output > Primary 

LOV Mode). However, the LOV mode does not apply to 

re-clocked outputs. The re-clocked outputs will be undetermined if 

the input video format is not supported, or if the input video is lost.

Mode 2: Independent Scaled Outputs and Frame Sync 
Outputs

Figure 3-2. Independent Scaled Outputs and Frame Sync Outputs

This mode is active when you select Frame Sync: Dual Channel in 

Video > Output > DA Output Select.

Video frame 
sync

Program  

and monitor 

outputs

SDI 

Input

Scalar and

audio /ancillary 

processor

Frame 

synced 

outputs
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Four frame synchronized outputs of the input video and four scaled 

outputs are available in this mode. The frame synchronizer and the 

scalar processor are on separate paths. This makes it possible for you to 

configure the XHD6801+ as an independent four-output frame 

synchronizer and a four-output up/cross/downconverter. The following 

special features and limitations apply to this video processing mode:

� The input video standard control for the frame synchronizer in 

effect also controls the output video standard of the frame 

synchronizer.

� The output video standard of the scalar is selectable through the 

scalar output video standard control (Video > Output > Output 

Video Standard Select). However, the video format of the frame 

synchronizer outputs is controlled by the frame synchronizer input 

video standard control.

� Two independent sets of horizontal and vertical phasing controls 

are available to both video frame synchronizer and scalar processor 

(Video > Processing > Synchronizer). This makes it possible for 

you to adjust the phasing of the frame-synchronized outputs and the 

scalar outputs independently with respect to the reference.

� The LOV parameter (Video > Output > Primary LOV Mode) 

controls the behavior of both the frame synchronizer outputs and 

the scalar processor outputs.

� Since the scalar processor resides on a path different than the frame 

synchronizer, the frame delay induced by the frame synchronizer 

will not be added to the scalar processing path and therefore the 

maximum frame delay through the scalar processing path is limited 

to two frames (the amount of propagation delay through the scalar 

processor). This setting is available in Audio > Other> I/O Delay 

Configuration. Also, there are some problems on the scalar 

processor when handling “dirty” video input. Without the frame 

synchronizer acting as a filter at the scalar video input, the scalar 

outputs may not be perfectly clean when there are glitches at the 

input video (for example, when the video format is changed).
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Mode 3: Frame Sync and Scaled Outputs

Figure 3-3. Frame Sync and Scaled Outputs

This mode is active when you select FS: Single Chan in Video > 

Output > DA Output Select.

In this mode, there are four frame synchronized outputs of the input 

video and four scaled outputs available. The scalar processor is located 

after the video frame synchronizer on the same path. However, putting 

both the frame synchronizer and the scalar on the same path prevents 

you from changing the phase relationship between the frame 

synchronized outputs and the scalar outputs. The following special 

features and limitations apply to this video processing mode:

� The input video standard control applies to both the video frame 

synchronizer and the scalar processor (Video > Input > SDI Input 

Standard Set). If the input video format does not match the input 

standard control setting, or if the input video is lost, both the frame 

synchronizer and the scalar processor will operate in the LOV 

mode.

� The output format of the scalar is selectable through the scalar 

output video standard control (Video > Output > Output Video 

Standard Select). However, the output video format of the frame 

synchronized outputs is controlled by the input video standard 

control.

� The horizontal and vertical phasing will apply to both video frame 

synchronizer and scalar processing as a single block (Video > 

Processing > Synchronizer). In other words, you cannot adjust the 

phase relationship between the frame synchronizer outputs and the 
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scalar outputs. The scalar outputs will always lag the frame 

synchronizer outputs by a fixed number of video frames (the 

amount of propagation delay through the scalar processor).

� If the input video format does not match the input standard control 

setting or if the input video is lost, the program and monitor outputs 

will either be frozen, undetermined (pass mode), black, or test 

pattern—according to the LOV mode setting (Video > Output > 

Primary LOV Mode). The frame synchronizer outputs will also 

either be frozen, undetermined (pass mode), or black.

Q-SEE Compliant Thumbnails

The XHD6801+ supports Q-SEE compliant thumbnails. To use Q-SEE 

compliant features, you must install the XHD6801+ in an 

FR6802+QXF frame that also contains a 6800+ETH module. 

When you open a Control window in Pilot or Navigator for the 

6800+ETH module, all Q-SEE compliant modules provide thumbnails 

on a Video Streaming tab. In addition, the XHD6801+ module’s 

Control windows have a Streaming tab where a thumbnail, updated at 

up to three frames per second, is displayed. 

For more information on Q-SEE compliant thumbnails, see your 

FR6802+QXF Frames Installation and Operation Manual.
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Changing Parameter Settings

There are two ways to change the parameters that control your module’s 

operation: CCS software applications and card-edge controls.

Using CCS software applications, such as + Pilot Lite, Pilot, or 

Navigator, you can view, set, and confirm your module’s parameter 

settings from your computer’s monitor. Using the card-edge controls, 

you can set parameters using the module’s rotary hex and navigation 

switches. 

You can use the information in this chapter to configure and operate 

your XHD6801+ using a CCS software application or the module’s 

card-edge controls. For more information about setting parameters 

using CCS software application or by using the module’s card-edge 

control, see “Changing Parameters Using CCS Software” on page 32 

and “Changing Parameter Settings Using Card-Edge Controls” on 

page 33 respectively. 

A complete list of XHD6801+ control parameters can be found in 

Chapter 4: “Parameters, LEDs, and Alarms” on page 59.

Changing Parameters Using CCS Software
Before using CCS software applications or hardware controls to change 

your module’s parameter settings, you must refresh (+ Pilot Lite) or 

discover (Pilot and Navigator) the module. Refresh and Discovery are 

the processes by which your CCS software finds, and then connects to 

your module.

Refreshing Your Module Using + Pilot Lite

When using + Pilot Lite to change your XHD6801+ control 

parameters, you must “refresh” the control connection between your 

6800+ frame and PC. To refresh the connection, from the + Pilot Lite 

menu bar, select File > Refresh. For information about controlling a 

device using + Pilot Lite, see your + Pilot Lite User Manual.
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Discovering an XHD6801+ Module

To discover your module, your Pilot or Navigator software must be in 

Build mode. Follow these steps: 

1. If the Discovery window is not open, click Tools > Discovery in the 

main menu. 

A Discovery window opens, most likely in the bottom left corner of 

the screen. 

2. Click Options, and then click Add.

3. Enter the IP address of the frame that contains your module, the 

frame that contains your ICE6800+ module, or the frame that 

contains a 6800+ETH module that provides access to your module. 

4. Click OK to close the Add IP address window, and then OK again 

to close the Discovery Options window. 

5. Click Start. 

This triggers Pilot or Navigator to run a discovery. 

6. When your discovery is complete, Discovery Completed is 

displayed in the Discovery window. 

7. To continue, click Save, to save the contents of your discovery to 

the Discovery folder of the Navigation pane. 

You can now switch to Control mode by selecting Operational Mode > 

Control. Double-click XHD6801+ in the Navigation pane. The 

Control window opens and displays the module’s controls.

Changing Parameter Settings Using Card-Edge Controls

Using the module’s rotary and navigation switches, you can change 

XHD6801+ parameter settings at the card-edge. You can view and 

confirm your changes using the On-screen display feature (see 

“Enabling On-Screen Display” on page 35).

Follow these steps to change the parameter settings at the card edge:

1. Rotate the mode select rotary switch (hex switch) to 0.
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2. Once the hex switch is set to 0, toggle the navigation switch up or 

down to select a bank. 

View the control LEDs next to the navigation toggle switch. A lit 

LED indicates which bank is currently selected.

3. Rotate the hex switch to the parameter number (1 to 9) or letter 

(A to F) of the option you want to set.

4. Toggle the navigation switch to select and set the value of the 

chosen parameter.

Table 3-1. Bank Select LEDs

Bank 
Number

Bank 0 LED
(first top 
LED)

Bank 1 LED
(second 
top LED)

Bank 2 LED
(third top 
LED)

Bank 3 LED 
(fourth top 
LED)

0 Off Off Off Off

1 On Off Off Off

2 Off On Off Off

3 On On Off Off

4 Off Off On Off

5 On Off On Off

6 Off On On Off

7 On On On Off

8 Off Off Off On

9 On Off Off On

10 Off On Off On

11 On On Off On

12 Off Off On On

13 On Off On On

14 Off On On On

15 On On On On
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5. Rotate the hex switch to another parameter number/letter in the 

current bank, and then repeat step 4.

or

Rotate the hex switch to 0 again to select a different bank, and then 

repeat steps 3 and 4.

Note

Harris recommends that you use the software controls to aid in 

viewing, setting, and confirming parameter values.

Enabling On-Screen Display
You can use the On-screen Display (OSD) monitoring feature to view 

the current parameter selections on your output display. When the 

On-Screen Display parameter is turned on, the current parameter 

selections are displayed on the module’s SDI Program/Monitor Out 1 

and SDI Program/Monitor Out 2 outputs. This features makes 

configuring the XHD6801+ using the card-edge controls much easier. 

To enable OSD monitoring, select Video > Output > Config > 

On-Screen Display. To change the transparency of the OSD, select 

Video > Output > Config > OSD Transparency.

OSD can be turned On/Off at the card edge, using Bank 0, Switch 2 

(0,2).

Recalling Default Parameter Settings
You can use the module’s Factory Recall parameter to return all of the 

module’s parameters to factory default settings. To return this module to 

its default settings, select Other > Factory Default > Yes.

Reading Software and Hardware Versions
You can see the current software and hardware versions of the 

XHD6801+ by checking the Hardware Version and Firmware 

Version read-only parameters near the end of the parameter list (see 

“Control Parameters” on page 60). These parameters appear in the 

on-screen display and in CCS software applications.
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Entering License Keys

Optional license keys are available to add new capabilities to your 

existing module. (Contact your product sales representative for details.)

Before you purchase a license key, you must obtain your module’s 

serial number. Select Other > Serial Number. The module’s current 

capabilities are shown when you select Other > Options.

Table 3-2 lists the available XHD6801+ upgrade licence keys.

You can use a CCS software application, such as CCS +Pilot Lite, Pilot, 

and Navigator, as well as NUCLEUS control panels to enter license 

keys. Additionally, you can enter the license keys with a web browser if 

your module is in a frame with (or connected to a frame with) a 

6800+ETH+HTTP module. License keys cannot be entered at the 

module’s card edge, but you can view the License Key parameter if the 

On Screen Display parameter is enabled. 

Using CCS, you can enter your license key by selecting Other > 

License Key.

To confirm that your license key has been accepted and activated, select 

Other > Options.

Note

Before you can enter and activate your upgrade license key, you 

must either Refresh or Discover your XHD6801+ module as 

described in “Refreshing Your Module Using + Pilot Lite” on 

page 32 and “Discovering an XHD6801+ Module” on page 33.

Table 3-2. Available Upgrade License Keys

Module Type 
Before Upgrade

License Key Upgrade
Module Type 
After Upgrade 

XHD6801+UCT Up/cross/downconversion

(XHD68+-UC-UG-UCD)

XHD6801+UCDT

XHD6801+DT Up/cross/downconversion

(XHD68+-D-UG-UCD)

XHD6801+UCDT
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Aspect Ratio Conversion 
For the module output, you can select either a standard ARC setting, or 

one of 10 of your own customized preset ARC settings. When using the 

ARC function, ensure that you select the correct output in Out Aspect 

Ratio (Video > Processing > ARC > Out Aspect Ratio). 

Setting a Standard Aspect Ratio
To select a standard aspect ratio for the output image, select ARC 

Preset Up, ARC Preset Cross, ARC Preset Down, or ARC Preset 

SD-ARC (found at Video > Processing > ARC). Each of these 

parameters corresponds to one of the four conversion modes (up, cross, 

down, and SD-ARC.) As the module changes between conversion 

modes—based on either an output format change or an input format 

change— the corresponding ARC preset will be applied.

The available standard aspect ratios depend upon the operating mode of 

the XHD6801+. In other words, for example, an ARC setting that is 

visible in upconversion may not be visible in downconversion.

In some modes, Pixel True is offered as an option. There is no actual 

scaling performed in Pixel True. Instead, each input pixel is mapped 

directly to one output pixel; you can use this preset to transport an SD 

picture embedded inside an HD stream.

The following standard ARC options are available:

� Anamorphic

� 4:3 Pillar Box

� 14:9 Pillar Box

� 16:9 Cut

� 4:3->21:9 Ltr

� 16:9 Letter Box

� 14:9 Letter Box

� 4:3 Cut

� 16:9->21:9 Ltr

� PixelTrue

� Preset 1-Preset 10

� AFD

� AFD - ALTR
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� VI

� VI - ALTR

� WSS

� WSS - ALTR

� Custom

Active Format Description (AFD) is a useful option that transmits data 

in the VANC portion of the SDI signal, enabling both 4:3 and 16:9 

television monitors to optimally present video with preset ARC and 

safe area information. 

Additional information on active format description begins on page 40.

Setting a Custom Aspect Ratio
You can scale and pan the output image to any size and location by 

using the various parameters of the custom aspect ratio feature. To use 

this feature, see the options in ARC Preset Up, ARC Preset Cross, 

ARC Preset Down, or ARC Preset SD-ARC (found at Video > 

Processing > ARC). This procedure is optional, but recommended, as it 

has the effect of making the custom ARC settings “live.” In other 

words, changes to these parameters will immediately appear on the 

program output. Use Horizontal Scale, Vertical Scale, Horizontal 

Offset, and Vertical Offset (found in Video > Processing > ARC) to 

set the size and position that you need.

Saving, Selecting and Recalling Custom Aspect Ratios

You can save, select, and recall custom aspect ratios in the XHD6801+ 

modules. These controls are all found in the Video > Processing > 

ARC section.

Saving a Custom Aspect Ratio

To save a custom aspect ratio, follow these steps:

1. Ensure the Horizontal Scale, Vertical Scale, Horizontal Offset, 

and Vertical Offset parameters have been set to your desired 

values.

2. In the ARC Preset Save parameter, select one of the aspect ratio 

preset slots for storage.
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Selecting a Saved Custom Aspect Ratio

To select one of the custom saved aspect ratios for the output image, 

follow these steps:

1. Select ARC Preset Up, ARC Preset Cross, ARC Preset Down, or 

ARC Preset SD-ARC. 

2. Select one of the ten Presets.

Recalling a Saved Custom Aspect Ratio

By selecting the ARC Preset Recall parameter, you can also recall any 

built-in standard or custom saved aspect ratio settings into the custom 

aspect ratio controls. This operation will not affect the output image 

unless you have selected Custom in ARC Preset Up, ARC Preset 

Cross, ARC Preset Down, or ARC Preset SD-ARC .

The ARC Preset Recall operation will overwrite the current settings of 

Horizontal Scale, Vertical Scale, Horizontal Offset, and Vertical 

Offset. If you perform an aspect ratio recall when you have selected 

Custom in ARC Preset Up, ARC Preset Cross, ARC Preset Down, 

or ARC Preset SD-ARC, the output image aspect ratio will change to 

reflect the newly recalled ARC values.

Overscan Mode

The overscan mode is similar to a zoom mode. When enabled, it 

discards a specified number of lines and columns of pixels around the 

borders of the input image active picture region before processing.

For example, the active picture region for 525 standard starts on line 21 

and ends at line 262. Therefore, an overscan setting of one line implies 

that upconversion starts at line 22 and ends at line 261. In addition to 

the two discarded lines, the first and last pixel of each remaining line in 

the active picture region are discarded.

Note

VBI is not passed with the XHD6801+. Teletext and WSS can be 

re-embedded on the output side of the module.

The overscan mode prevents data embedded in the active picture region 

(usually line 21), such as closed captioning, from being converted.

To enable the overscan mode, select Overscan Lines parameter (Video 

> Processing > ARC > Overscan Lines) and then select the number of 

rows and columns for cropping. 
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Using the overscan control you can also discard picture ramp-up and 

ramp-down regions commonly present in material digitized from 

analog video sources. 

If you are using an XHD6801+ with a downstream keyer, and the keyed 

image appears with a dark border around it, the border is caused by this 

shaping of the incoming video frame. Use the Overscan Lines 

parameter to minimize this border effect.

Active Format Description

Active Format Description (AFD) transmits data in the VANC portion 

of the SDI signal, enabling both 4:3 and 16:9 television monitors to 

optimally present video with preset ARC and safe area information. 

Without AFD, converted video may appear distorted or “cut off” when 

it appears on different monitors. The XHD6801+ can encode or decode 

AFD; it can also encode or decode earlier Video Index (VI) and Wide 

Screen Signalling (WSS) formats.
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The AFD feature of the XHD6801+ complies with SMPTE 2016 and 

includes nine possible 4:3 configurations and eight possible 

configurations in 16:9. Figure 3-7 on page 46 describes the 4:3 AFD 

configurations; Figure 3-8 on page 47 describes the 16:9 AFD 

configurations.Figure 3-4 shows two comparisons of a signal that is 

encoded with AFD and without AFD. 

Figure 3-4. AFD/Non-AFD Comparisons

SD-SDI 4:3 HD-SDI 16:9

Full frame Pillarbox

Down

Up
Postage stamp

Full frame

SD-SDI 4:3

16:9 Letterbox

SD-SDI 4:3

Up

Postage stamp

Full frame

HD 16:9

Using active format 
description (best result) 

Without active format description 
(undesirable result)

Using active format 

description, the original image 

information is maintained 

throughout the entire 

conversion, creating the best 

possible viewing area .
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Figure 3-5 shows different applications of AFD insertion and decoding.

Figure 3-5. AFD Block Diagram

The AFD feature of the XHD6801+ includes nine possible SD-SDI 

configurations and eight possible configurations in HD-SDI. Figure 3-9 

on page 48 describes the SD-SDI AFD configurations; Figure 3-10 on 

page 49 describes the HD-SDI AFD configurations. 

AFD, VI, and WSS Detection
AFD, VI, and WSS data that is embedded in the incoming video can be 

detected by the XHD6801+, and read from the following input 

parameters that are found in the Video > Input > De-embedder path: 

� AFD Present 

� VI Scan Present (Use the VI Detect Line Field 1 and VI Detect 

Line Field 2 parameters to determine where in the video signal to 

look for VI information)

� VI AFD Present

� WSS Present (Use the WSS Detect Line parameter to determine 

where in the video signal to look for WSS information)
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AFD, VI, and WSS Processing
Incoming AFD, VI, and WSS data can be used for automatic aspect 

ratio control when the ARC Preset parameter is set to one of these 

values in the Video > Output > Embedder path: 

� AFD

� AFD (ALTR)

� VI

� WSS

� WSS (ALTR) 

See Figure 3-9 on page 48, Figure 3-10 on page 49, Figure 3-11 on 

page 50, and Figure 3-12 on page 51 for descriptions of how the 

automatic ARC control will act when given an AFD, VI, or WSS code 

input.

AFD, VI, and WSS Output
AFD, VI, and WSS data can be inserted into an output video stream 

either manually or automatically. This function is controlled by the 

AFD Control, VI Control, and WSS Control parameters located in 

the Video > Output > Embedder path.

The Insert Auto option of the AFD Control, VI Control, and WSS 

Control parameters will embed the data that is automatically selected 

by the module, based on one of the following:

� The current ARC settings (via Video > Processing > ARC)

� The current AFD/VI/WSS code input that is detected in the 

incoming video signal

� A selected option in the ARC Preset Up, ARC Preset Cross, ARC 

Preset Down, or ARC Preset SD-ARC parameters (via Video > 

Processing > ARC)

If you select Custom instead of Insert Auto in the AFD Control, VI 

Control, and WSS Control parameters, you can change the output 

code by selecting a different option in AFD Select, VI Select, or WSS 

Select. These parameters are also located in the Video > Output > 

Embedder path (in Table 4-1 on page 63).
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Additionally, if you are using VI according to the SMPTE Proposed 

RP-186+ standard as of January 11, 2007, you must ensure you have 

enabled the standard by following this path: Video > Output > 

Embedder > SDI Out VI with AFD (default setting is Yes).

In the event that the current ARC is controlled by AFD, VI, or WSS, 

and this data disappears from the input signal, the XHD6801+ provides 

you with two options:

� Keep the current aspect ratio as set by the last AFD, VI, or WSS 

data.

� Reset to the aspect ratio settings that were in use before the AFD, 

VI, or WSS data took control.

The Auto Arc Reset parameter controls this feature. Select Yes to have 

the module reset to older values in the event of a loss of data; select No 

(the default) to retain the current ARC settings in the event of a loss of 

data.

At this time, Bar Data and Pan-Scan for VI and AFD are not 

supported.
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AFD Descriptions
In the following pages, Figures 3-7 to 3-12 show the different AFD 

code descriptions. Comparable WSS and VI templates are included in 

the SD-SDI descriptions.

Figure 3-6. Explanation of AFD Diagrams

Bounding box represents

the coded frame.

The smallest rectangle enclosing

the white regions indicates the area

of essential picture information.

Black regions indicate areas

of the picture that do not

contain useful information and

should be cropped by the

receiver where appropriate.

Gray regions indicate areas of the picture

that may be cropped by the receiver

without significant loss to the viewer.
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Figure 3-7. Available AFD Select Options when OutAspectRatio is Set to 4:3
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Figure 3-8. Available AFD Select Options when OutAspectRatio is Set to 16:9
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Figure 3-9. Available AFD Select, VI Select, and WSS Select Options When Converting from 

4:3 to 16:9

4:3 to 16:9 conversion
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Figure 3-10. Available AFD Select, VI Select, and WSS Select Options When Converting 

from 4:3 to 4:3
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Figure 3-11. Available AFD Select, VI Select, and WSS Select Options When Converting 

from 16:9 to 4:3
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Figure 3-12. Available AFD Select, VI Select, and WSS Select Options from 16:9 to 16:9
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Closed Captioning and DVB Teletext Captioning

Although North America has dedicated standards for closed captioning 

of video (EIA-608 and 708), many countries in Europe and elsewhere 

have not yet adopted formal standards. For these countries, closed 

captioning is part of the DVB Teletext System as described in ITU-R 

BT-653-3. These specifications define all Teletext Systems (Systems A, 

B, C, D) used in the world and are also known as the World System 

Teletext (WST). A Teletext system is made of several pages of various 

data information and CC data is described in one these pages. System B 

is used in Australia, the UK, and Germany, among other countries.

Australian closed captions are inserted on line 21/334 in analog PAL 

broadcast signals, as per the ITU-R BT-653-3. When analog PAL is 

produced or converted to SDTV (625 digital), a digitized version of the 

closed captioning appears on line 21/334 (in the same way line 21 on 

NTSC signals is digitized and appears on the line 21 of SD-SDI 

signals). The ITU-R BT-653-3 document proposed by Free TV 

Australia indicates how to carry this CC data into the VANC area of 

SD-and HD-SDI signals by use of the SMPTE 334M VANC embedding 

protocol. For digital broadcasting, Australia intends to use the ETSI EN 

300 472 standard that specifies the conveyance of ITU-R System B 

Teletext in DVB bit streams.

Setting Closed Captioning and Teletext
To make changes to the default CC and Teletext settings, use the Closed 

Captioning/Teletext Embed and Closed Captioning/Teletext Embed 

Line parameters from the path Video > Output > Embedder path. 

To verify the presence of the embedded CC, use the Input Closed 

Captioning/Teletext Present parameter (Video > Input > 

De-embedder path).

If you have purchased and enabled the XHD6801+ closed captioning 

feature, you can use the closed captioning parameters to enable and 

select the video line in which you want to embed closed captioning 

data. Contact your product sales representative for information about 

obtaining a closed captioning license key. If you have already 

purchased a license key, but have not yet enabled the feature, see 

“Entering License Keys” on page 36.
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Audio Configuration

XHD6801+ modules process embedded audio. The input embedded 

audio from SDI 1 is demultiplexed (de-embedded) and synchronized to 

the video, delayed to match the video processing delay, processed, and 

then remultiplexed (re-embedded) into HD- and SD-SDI video output. 

Up to four groups of audio can be embedded into the video stream.

Audio Controls
XHD6801+ modules can route audio from one of several sources to the 

outgoing SDI signal (up to 8 channel pairs can be embedded). 

The modules are capable of demultiplexing up to four groups of 

embedded audio from the primary video SDI stream, and embedding up 

to four groups into the output SDI stream. XHD6801+ modules can 

select up to eight channel pairs of embedded audio.

The Demux Group Present and Demux Channel Pairs Present 

parameters (Audio > Input > Status > Demux Group Present and 

Demux Channel Pairs Present) indicate which groups and channel 

pairs have audio present in the video inputs.

See page 55 for more information about audio status parameters.

Audio Routing

Input

To manually configure the audio inputs, you will need to select options 

in the Audio > Input > Routing section. Set your options in the SRC1 

to SRC8 Input Select parameters. 

The default settings for the inputs follow this pattern:

� SRC1 Input Select = SDI 1 Group 1 Channel 1/2

� SRC2 Input Select = SDI 1 Group 1 Channel 3/4

� SRC3 Input Select = SDI 1 Group 2 Channel 1/2

� SRC4 Input Select = SDI 1 Group 2 Channel 3/4, etc.
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Output

To manually configure the output of the audio, select Enable in Mux 

Group 1 Enable to Mux Group 4 Enable. (This is found at Audio > 

Output > Embedder > Mux Group 1 Enable to Mux Group 4 

Enable.) 

Then set your options in the Routing section (Audio > Output > 

Routing > Mux Group x Channel x).

The default audio routing settings follow this pattern: 

� Mux Group 1 Channel 1 = SRC 1A

� Mux Group 1 Channel 2 = SRC 1B

� Mux Group 2 Channel 1 = SRC 2A

� Mux Group 2 Channel 2 = SRC 2B, etc.

In addition to selecting audio sources from the video groups, four 

custom tone generators are available, as well as Mute and SMPTE 

RP155 and EBU R68 tones. To set the four custom tones, follow the 

path to Audio > Other > Tones > Tone Generators 1 to 4 Level.

Audio Proc Amp
Gain, bypass, and delay controls are available for the left and right side 

of each of the processed audio channels. You can individually adjust the 

gain and delay of the left and right sides of each channel using the 

control parameters in the Gain and Delay sections (Audio > 

Processing > Gain or Delay).

The audio can contain non-PCM audio data (in other words, it is 

indicated by bit 1 of channel status bits being set for Non-Audio 

instead of Audio as shown on page 90). In this case, the sample rate 

converter must be bypassed to ensure audio integrity. You must 

individually indicate which sample rate converter or gain to bypass 

using the SRCx Gain/Bypass parameters (Audio > Input > Bypass > 

SRCx Gain/Bypass). Select Manual in the SRC/Gain Bypass Mode 

to enable these individual controls. 

If you set SRC/Gain Bypass Mode to Auto, the audio will be 

monitored, and if non-PCM audio data is detected, the sample rate 

converter for that side of the channel will be bypassed.

In addition to the mute controls that control audio pairs individually, a 

Master Mute control mutes all of the audio channel pairs (Audio > 

Processing > Gain > Master Mute). Also, if the audio source for either 

side of a given audio channel does not have any incoming audio, the 

signal will be automatically muted. 
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Audio Status Parameters
The read-only Demux Group Present parameter (in the Audio > Input 

> Status path) indicates which groups are present in the video input (see 

Figure 3-13). The “=” indicates no audio is detected for a particular 

group, while the letter P indicates the presence of audio. For example, 

“= P= =” means the XHD6801+ detects audio in Group 2, but no audio 

is detected in the other three groups.

Figure 3-13. Demux Group Present and Demux Group Error

The Demux Group Error parameter (also in the Audio > Input > 

Status path) displays errors in the same way. In a string of “=” signs, 

the letter E indicates an error for that audio group.

Demux Channel Pair Present displays the eight channel pairs, with 

the letter P indicating audio presence (see Figure 3-14).

Figure 3-14. Demux Channel Pair Present/Type

Demux Channel Pair Type displays the eight channel pairs, with the 

letter A indicating PCM audio, and the letter D indicating non-PCM 

(data).

= = = =  
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========

Channel Pair 1, Group 1 
Channel Pair 2, Group 1 
Channel Pair 1, Group 2 
Channel Pair 2, Group 2 

Channel Pair 2, Group 4

Channel Pair 1, Group 4

Channel Pair 2, Group 3

Channel Pair 1, Group 3
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GPI

The XHD6801+ modules provide four GPI inputs and two GPI outputs 

for automation. These are open collector style inputs with 

approximately 10 KΩ pull-ups to +5V. This means that you can use 

“contact closure-to-ground” switches to control these GPI inputs.

The GPI actions are controlled by these parameters (in the Video > 

Other > GPI path):

� GPI In Trigger 1 to 4

� GPI In Event 1 to 4

� GPI Status

� GPI Out State 1 and 2 

� GPI Out Event 1 and 2 

� GPO Status

All GPI events occur in the order they are triggered and will override 

older events. For example, if the three GPI events are set up as follows, 

the resulting ARC setting will appear as shown in Figure 3-15.

� GPI Trigger 1 = Rising Edge, GPI Event1 = 16:9 Anamorphic

� GPI Trigger 2 = Falling Edge, GPI Event2 = Preset 3

� GPI Trigger 3 = Rising Edge, GPI Event3 = Pixel True

� ARC Preset = 4:3

Figure 3-15. Processing of Multiple GPI Events

 
GPI 1

GPI 2

GPI 3

4:3 ARCPreset 16:9Anmphc pixelTrue Preset 3 
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Video Keying

The video keying feature is activated by following the Video > Output 

> Config > Video Keying path. When enabled, the key image appears 

on the SDI Program/Monitor Out feed. The On Screen Display 

feature (Video > Output > Config > On Screen Display) also appears 

on the SDI Program/Monitor Out feed when it is enabled.
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Parameters, LEDs, and Alarms

Overview

This chapter describes the parameters, LEDs and alarms used on the 

XHD6801+.

The following topics are covered:

� “Control Parameters” on page 60

� “LEDs and Alarms” on page 69
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Control Parameters

Table 4-1 on page 63 lists all of the available parameters and options 

for the XHD6801+ modules. The parameters are listed in the order that 

they appear in CCS Pilot and Navigator. If you are using + Pilot Lite, 

some parameters in the list may not appear in the order as they appear in 

the software. Also, because of space limitations, some rarely-used 

parameters will not appear in the OSD list.

On Screen Display Monitoring
If you are using card-edge controls to configure your XHD6801+ 

module, you can use the OSD Monitoring feature to view the current 

parameter selections. When the On-Screen Display parameter is turned 

on, the current parameter selections are displayed on module’s 

monitoring outputs. For information on enabling OSD Monitoring, see 

“Enabling On-Screen Display” on page 35.

Parameter Table Notes
When viewing the control parameter tables, observe the following:

� Shaded table rows indicate read-only (feedback) parameters. 

� Bolded parameter options indicate the default settings for the 

parameter. 

� The bank selection and rotary switch combinations for each 

parameter and parameter option are listed in the tables under the 

Bank, Switch heading. For information about navigating through 

the parameter list using the card-edge controls, see “Changing 

Parameter Settings Using Card-Edge Controls” on page 33.

� Parentheses indicate a series of parameters, usually sequentially 

numbered.
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INSERT 

OSD TABLE

HERE
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INSERT 

OSD TABLE

HERE
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Table 4-2. Simplified Parameter List 

Level One Level Two Level Three Level Four

Video Active Bypass is 

Valid

Input SDI 1 Input Standard 

Set

Status SDI 1 In Standard 

SDI 1 Standard Mismatch

CRC/EDH SDI 1 CRC/EDH Error Count

SDI 1 EDH Present 

Error Poll Interval 

SDI 1 Error Counter Reset

De-embedder AFD Present

VI Scan Present

VI AFD Present

VI Detect Line Fields (1 and 2)

WSS Present

WSS Detect Line 

Input CC/TT Present

CC/TT Error Control

Output Output Video Standard 

Select 

Global Frame Rate 

Scalar Bypass

DA Output Select

Primary LOV Mode 

Configuration On Screen Display 

OSD Transparency Level

Test Pattern Display

Test Pattern Select
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Video (cont’d) Output (cont’d) Configuration (cont’d) Safe Area Graticles

Video Keying

 Background Color

Embedder AFD Control

AFD Embed Line

AFD Select

VI Control

VI Embed Line

VI Select

SD Out VI with AFD

WSS Control

WSS Embed Line

WSS Select

CC/TT Embed

CC/TT Embed Line

Processing Synchronizer Input Frame Delay 

DA: Channel: Vertical Phase 

DA: Channel: Horizontal Phase

Program Channel: Vertical Phase

Program Channel: Horizontal Phase

Force Freeze 

Video Frozen 

ARC ARC Mode Feedback

ARC Preset Up

ARC Preset Cross

ARC Preset Down

ARC Preset SD-ARC

Table 4-2. Simplified Parameter List 

Level One Level Two Level Three Level Four
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Video (cont’d) Processing (cont’d) ARC (cont’d) ARC Preset Save 

ARC Preset Recall 

Horizontal Offset

Vertical Offset

Horizontal Scale 

Vertical Scale 

ARC Horizontal Offset Feedback 

ARC Vertical Offset Feedback 

ARC Horizontal Scale Feedback 

ARC Vertical Scale Feedback

Overscan Up

Overscan Cross

Overscan Down

Overscan SD-ARC

Out Aspect Ratio

Auto ARC Reset

Video Processing Proc Amp Enable

Luma Gain

Chroma Gain

Black Level

Chroma Offset

Hue Phase

Black Clip Enable

Black Clip Level

White Clip Enable

White Clip Level 

Horizontal Bandwidth 

Vertical Bandwidth 

Table 4-2. Simplified Parameter List 

Level One Level Two Level Three Level Four
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Video (cont’d) Processing (cont’d) Video Processing Noise Reduction

Block Artifact Noise Reduction

Mosquito Noise Reduction

Detail Enhance Level

Detail Enhance Threshold

Audio Input Demux Error Control

Status Demux Group Present

Demux Group Error

Demux Channel Pair Status

Channel Swap Demux Group 1 Channels 1 and 2 Swap

Demux Group 1 Channels 3 and 4 Swap

Demux Group 2 Channels 1 and 2 Swap

Demux Group 2 Channels 3 and 4 Swap

Demux Group 3 Channels 1 and 2 Swap

Demux Group 3 Channels 3 and 4 Swap

Demux Group 4 Channels 1 and 2 Swap

Demux Group 4 Channels 3 and 4 Swap

Routing Sample Rate Converter (1 to 8) Input 

Select 

Bypass Sample Rate Converter/Gain Bypass 

Mode

Sample Rate Converter 1 to 8 Bypass 

Feedback

Sample Rate Converter (1 to 8) Gain 

Bypass

Output Embedder Mux Group Error

SD Embed 24-bits Enable 

Mux Group (1to 4) Enable 

Table 4-2. Simplified Parameter List 

Level One Level Two Level Three Level Four
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Audio (cont’d) Output (cont’d) Routing Mux Group 1 Channel (1 to 4) 

Mux Group 2 Channel (1 to 4) 

Mux Group 3 Channel (1 to 4) 

Mux Group 4 Channel (1 to 4) 

Processing Audio Control Style

Audio Type Audio Type (1 to 16 or Ch. 1 to 8, L to R) 

Gain Master Mute 

V-bit Mute Enable 

Gain Lock

Gain (1 to 16 or Ch. 1 to 8, L to R) 

Delay Delay Lock

Delay (1 to 16 or Ch. 1 to 8, L to R) 

Phase Invert Invert (1 to 16 or Ch. 1 to 8, L to R) 

Other Fade Time

I/O Delay Config I/O Delay Sample Rate Converter (1 to 8)

Other Tones (ToneGen [1 to 4] Level)

Reference Reference Standard 

Valid Reference Std.

Reference Locked

Reference Source

Other License Key 

License Key Status

Serial Number 

Firmware Version

Firmware Date

Firmware Time

Options

Factory Default

Table 4-2. Simplified Parameter List 

Level One Level Two Level Three Level Four
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.

Other (cont’d) GPI GPI In Trigger (1 to 4)

GPI In Event (1to 4)

GPI Status 

GPI Out State (1 to 2)

GPI Out Event (1to 2) 

GPO Status

Table 4-2. Simplified Parameter List 

Level One Level Two Level Three Level Four
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LEDs and Alarms

Monitoring LEDs
The XHD6801+ have monitoring LEDs that serve as a quick 

monitoring reference. Figure 4-1 shows the location of the monitoring 

LEDs on a typical 6800+ module. Table 4-2 on page 70 describes the 

meaning of the card-edge LEDs, from left to right.

Figure 4-1. Location of XHD6801+ LEDs

Monitoring 

LEDs
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Module Status LEDs

The XHD6801+ modules do not have any card-edge alarms. Instead, 

the module status LED on the corner of the module lights up if an error 

is detected. See Figure 1-1 on page 6 for the location of this LED, and 

Table 4-3 for a definition of the LED colors.

Alarms are usually logged and monitored within software control 

applications such as + PilotLite or CCS Pilot. See the appropriate 

software control user manual or online help for more information.

Table 4-3. LED Status Indicators 

LED Description Color Indication

50-59 Indicates the frame rate for the input video 

standard

� Green: 59

� Off: 50

525 Indicates the input standard is 525 Green: 525 input standard is detected

625 Indicates the input standard is 625 Green: 625 input standard is detected

720p Indicates the input standard is 720p Green: 720p input standard is detected

1080i Indicates the input standard is 1080i Green: 1080i input standard is detected

1080p Indicates the input standard is 1080p Green: 1080p input standard is detected

Audio1 Reports the presence of audio group 1 in the input 

video stream

Green: Group 1 audio is present

Audio2 Reports the presence of audio group 2 in the input 

video stream

Green: Group 2 audio is present

Audio3 Reports the presence of audio group 3 in the input 

video stream

Green: Group 3 audio is present

Audio4 Reports the presence of audio group 4 in the input 

video stream

Green: Group 4 audio is present

CC Indicates the presence of closed captioning Green: Closed captioning data is present

Reference Indicates the presence of a valid reference signal Green: Valid signal is present
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Note

If the LED is flashing red, please contact your Customer Service 

representative.

Alarms
Table 4-4 describes the specific alarms for XHD6801+ modules. You 

can only identify specific alarms using a software control application.

Table 4-4. LED Color and Meaning

LED Color 
Sequence

Meaning

Off There is no power to the module; the module is not 

operational.

Green There is power to the module; the module is operating 

properly.

Red There is an alarm condition.

Flashing Red The module has detected a hardware/firmware fault.

Amber The module is undergoing configuration.

Table 4-5.  XHD6801+ Alarms 

Alarm Name Alarm Meaning
Alarm 
Level

SDI 1 Std Mismatch There is a mismatch between reference video and video standard Major 

SDI 1 Loss of Video The module detects a loss of video at the SDI 1 input Major 

Processing Bypass Active The Scalar Bypass switch (Video > Output > Scalar Bypass) is 

turned on. 

Minor

Reference Not Locked Loss of locked reference Major 

Teletext Parity Error The teletext input has a parity error Minor

Teletext Frame Error The teletext input has a frame error. Minor

Master Mute On The master audio mute is enabled. Minor

PCM Vbit Mute On The PCM outputs are automatically muted when the V-bit is set. Minor
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Chapter 5

Specifications

Overview

The following specification tables appear in this chapter:

� “SD/HD-SDI Video” on page 74

� “Genlock” on page 75

� “SDI Video Outputs” on page 76

� “Audio Delay (Data Out)” on page 77

� “Performance” on page 77

Specifications and designs are subject to change without notice.
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Inputs

SD/HD-SDI Video

Table 5-1. SD/HD-SDI Video Input Specifications

Item HD-SDI Specification SD-SDI Specification 

Number of inputs 1

Standards SMPTE 292M (1.485, 1,485/1.001 

Gbps)

SMPTE 259M-C 270 Mbps, 525/625 

component video 

Frame rate � 1080i: 50, 59.94 Hz

� 720p: 50, 59.94 Hz

� 486i: 59.94 Hz

� 576i: 50 Hz

Connector BNC per IEC 169-8 BNC per IEC 169-8

Impedance 75Ω 75Ω

Return loss >15 dB (typical) from 5 MHz to 1485 

MHz

>15 dB (typical) from 5 MHz to 270 MHz

Equalization Adaptive cable equalization for up to 

328 ft (100 m) (typical) of Belden 

1694A coaxial cable at 1.485 Gbps

Adaptive cable equalization for up to 700 ft 

(230 m) (typical) of Belden 8281 co-axial 

cable 
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Genlock

Table 5-2. Genlock Input Specifications

Item Specification

Connector BNC per IEC 169-8

Impedance 75Ω

Return loss > 40 dB 25 Hz to 30 MHz (SMPTE 318M-1999)

Common mode range � 5.5 V pk-to-pk

Input level � NTSC/PAL-B (1 V pk-to-pk, -4.5 dB to 6.0 dB)

� ± 300 mV, -4.5 dB to 6.0 dB for Tri-Level Sync 

�1080i: 59.94/50

�1080p: 29.97/25

Locking range ± 6 ppm (sync lock only, no burst lock)

Signal type � NTSC/PAL-B analog composite

� ± 300 mV Tri-Level Sync (1080i/720p)

Standard SMPTE 170M (NTSC), ITU-R BT.470-6 (PAL-B), 

SMPTE 274M (1080i, 1080p)
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Outputs

SDI Video Outputs

Table 5-3. SD/HD-SDI Reclocked Output Specifications

Item HD-SDI Specification SD-SDI Specification

Number of outputs 8

Standards SMPTE 292M (1.485, 1.485/1.001 

Gbps)

SMPTE 259M-C (270 Mbps, 525/625 

component video)

Connector BNC per IEC 169-8 BNC per IEC 169-8

Impedance 75Ω 75Ω

Return loss >15 dB (typical) from 5 MHz to 1485 

MHz

>15 dB (typical) from 5 MHz to 270 MHz

DC offset 0.0 V ± 0.5 V 0.0 V ± 0.5 V

Signal level 800 mV ± 10% 800 mV ± 10%

Rise and fall time <270 ps (20% to 80%) 400 to 1500 ps (20% to 80%)

Overshoot <10% of amplitude (all outputs 

terminated)

<10% of amplitude (all outputs terminated)

Jitter � Timing <1 UI pk-to-pk

� Alignment <0.2 UI pk-to-pk

<0.2 UI pk-to-pk



XHD6801+ Installation and Operation Manual 77

Chapter 5: Specifications

  

Miscellaneous

Audio Delay (Data Out)

Performance 

Table 5-4. Audio Delay Specifications

Item Specification

Number of outputs 1

Connector BNC per IEC 169-8

Impedance 75Ω

Return loss >20 dB (typical) to 6 MHz

Table 5-5. Audio Delay Specifications

Item Specification

Power consumption 17.5 W

Operating temperature 41° to 113°F (5° to 45°C)
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Appendix A

Communication and Control

Troubleshooting Tips

Overview

Find the following troubleshooting information in this appendix:

� “Software Communication Problems” on page 80

� “Hardware Communication Problems” on page 83



80 XHD6801+ Installation and Operation Manual

  

Appendix A: Communication and Control Troubleshooting Tips

Software Communication Problems

The frame is powered up, but the module does not 

communicate with + Pilot Lite or CCS Pilot/Navigator.

Solutions

� Ensure you have specified the proper module slot. 

See your FR6802+ Frame Installation and Operation Manual for 

more information about slot identification.

� Verify whether there is an ICE6800+ or 6800+ETH module 

installed in the frame.

� FR6802+ frames only use ICE6800+ modules to communicate 

with CCS software and hardware.

� FR6802+QXF frames use ICE6800+ or 6800+ETH modules to 

communicate with CCS software and hardware.

� Remove any legacy 6800 series product that is in the frame.

+ Pilot Lite and CCS software cannot communicate with legacy 

6800 series products, even though these modules may operate with 

card-edge controls in an FR6802+ frame. Legacy 6800 products do 

not have the “+” symbol on their extractor handles.

� Check for bent pins on the back module by following this 

procedure:

a. Unplug the front module. 

b. Unscrew and remove the back module.

c. Inspect the 20- or 30-pin spring connector at the bottom of the 

back module (Figure 6-1 on page 81), and verify that the 

connector does not have any slightly bent or pressed pins.

d. Carefully reposition any bent pins; If this is not possible, 

contact Customer Support.
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Figure 6-1. Typical Back Module Spring Connector

The frame is powered up, but + Pilot Lite does not 

communicate with the module.

Solutions

� Ensure you have installed the correct cables between the PC and the 

frame:

� A null modem serial cable must be used between a PC and an 

FR6802+ frame (not a straight-through cable). At minimum, 

this requires that pins 2 and 3 are crossed, but pin 5 (ground) is 

straight-through to pin 5. 

� A USB cable must be used between a PC and an FR6802+QXF 

frame.

� Verify whether there is an ICE6800+ or 6800+ETH module 

installed in the frame.

� + Pilot Lite control is disabled if an ICE6800+ or 6800+ETH 

control module is installed in the frame.

� Set the Frame ID DIP switch settings correctly (the Frame ID DIP 

switch is located at the rear of the frame.)

� If only one frame is connected, set the DIP switch to 00.

� If multiple frames are used in a daisy-chain, set the DIP switch 

numbers consecutively to the following:
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� 00 (frame 1)

� 01 (frame 2)

� 10 (frame 3

� 11 (frame 4)

See your FR6802+ Frame Installation and Operation Manual for 

more information about frame ID switch settings.

� Check that the correct COM port is configured in + Pilot Lite and 

that another application is not using that COM port.

+ Pilot Lite and CCS software see the frame, but do not find 

all of the modules

Solutions

� Remove any legacy 6800 series products.

� Plug your modules in before starting the discovery.

� Start your discovery after the frame and all modules have fully 

powered up.

� Refresh + Pilot Lite (File > Refresh), and ensure that the installed 

modules are fully powered up first before discovery.

+ Pilot Lite and CCS Pilot/Navigator do not respond after 

they have been launched.

Solution

Close either + Pilot Lite or CCS Pilot/Navigator. Both programs cannot 

be running at the same time on the same PC.

+ Pilot Lite and CCS software show a module in the control 

window, but cannot control it.

Solution

1. Set the module’s Local/Remote jumper to Remote.

2. Ensure the module name in the Control window matches the 

module type in the frame. 

3. Gently push the module into its slot in the frame to ensure it is 

seated properly and powered up.

4. Verify that the Control window indicates the device is ready.
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Hardware Communication Problems

After a power failure, the frames and PC do not 

communicate.

Solution

1. Wait four minutes for the frames to recover from the power failure.

2. Close the + Pilot Lite or CCS software, and then restart the PC.

3. Restart the software application.

The module does not seem to work.

Solutions

� Ensure the correct frame is powered up.

� Verify that all appropriate rear connections are secure.

� Gently push the module into its slot in the frame to ensure it is 

seated properly.

� Ensure the back module does not have bent pins by following this 

procedure:

a. Unplug the front module. 

b. Unscrew and remove the back module.

c. Inspect the spring connector at the bottom of the back module 

(Figure 6-1), and verify the connector does not have any 

slightly bent or pressed pins.

d. Carefully reposition any bent pins; if this is not possible, 

contact Customer Support.
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